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Configuring and Calibrating
CO/CO2CAN Systems
using the Configuration Tool (V4+) and
Using the dashCAN™* Display

Important Note

Due to the nature of CAN instrumentation, you cannot just physically connect a measurement
module to a bus and expect data from that module to be available. The CO/CO2CAN measurement
module has to be set up to send the data required and the receiving device (i.e. data acquisition
software) has to know what is being sent. The setting up modules and the production of a .dbc file
used by the receiving device to understand the data sent is performed using the supplied
Configuration Tool. 8-1-2018
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Complex measurement systems can be easily built with
LambdaCAN*, NOxCAN*, CO/CO2CAN, and baroCAN
modules. Here is a five-channel lambda, O,, and NOXx pressure-
compensated, in-vehicle system.



Introduction

The Configuration Tool runs on your PC and uses a CAN communication device to
communicate with one or more ECM *CAN modules (i.e. CO/CO2CAN, LambdaCAN¥*,
NOxCAN*, baroCAN) or analyzers (i.e. NOx 5210, Lambda 5220, EGR 5230). While the
tool is being used with modules, just ECM modules set to stand-alone mode (see Appendix
B) should be connected to the CAN bus. While the tool is being used with analyzers, just
analyzers should be connected to the CAN bus. With analyzers, the Configuration Tool is
just used to produce .dbc files. However with modules, the Configuration Tool replaces the
analyzer’s display head as the user interface so it must do much more. This document
focuses on using the Configuration Tool with ECM CO/CO2CAN modules.

The Configuration Tool supports four CAN communication devices: Kvaser (recommended),
ETAS, Peak USB to CAN adapters, and the VectorCAN CAN adapter card. Driver software
for one of these adapters must be installed prior to using the Configuration Tool. This
software will be supplied with the adapter or be available on-line. The Configuration Tool is
delivered on a CD.

Once the adapter’s driver and the Configuration Tool software are installed, and with the
module(s) powered and connected to the CAN adapter, start the Configuration Tool software.
Click on the “Modules” tab, select the CAN adapter, and click on the “START” button.

The software will identify all modules on the bus and display them in the “Module” field. If
this does not happen, make sure that the CAN bus is properly terminated (i.e. resistors).
Open the Module field to see all the modules on the bus. If a module is not listed, one reason
could be that its Node ID is the same as another module. To resolve this, remove all modules
except the “missing” one from the CAN bus, STOP then START the software, and change
the conflicting module’s Node ID. Another reason that a module is not listed could be that
the module is in EIB mode instead of stand-alone mode. All modules must be in stand-alone
mode (see Appendix B).

To configure one of the modules (ex. change its Node ID) or to look at that module’s data,
you have to select that module in the “Module” field.

There are three things you can do with modules using the Configuration Tool:

1. Configure a module. This includes calibrating a sensor attached to the module.
2. Look at data coming from that module in real-time and optionally log it.
3. Produce a .dbc file to be used by your data acquisition program.

Alternatively, 1. and 2. (above) can be performed by user-written CAN communication with
the module. For information on how to do this and further detailed information about the
CO/CO2CAN module, refer to the CO/CO2CAN Instruction Manual.



Configuring a Module

Normally, you will be configuring a module to be used in stand-alone mode. Stand-alone
mode is used when the modules are connected to a CAN bus that goes directly to a data
acquisition system. In stand-alone mode, a module’s configuration is performed by selecting
one of the tasks in the “Task” field. When a module is connected to a NOx 5210, Lambda
5220, or EGR 5230 display head, it must be in EIB mode. In EIB mode, most of these tasks
are performed using the display head. Appendix B describes how to configure a module to
operate in one mode or the other.

The following assumes that the module is to be used in stand-alone mode. The tasks
available for the CO/CO2CAN modules are listed in Table 1.
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Change Node ID: Allowable range 0x01 to Ox7F (hex). When you assign a Node ID (NID),
the following CANs cannot be used by any other devices on the bus:
0x00, 0x80 + NID, 0x180 + NID, 0x280 + NID, 0x380 + NID, 0x480 + NID,
0x580 + NID, 0x600 + NID, 0x700 + NID, 0x7E4, 0x7ES.

View Module Information: Manufacturer’s Name, Hardware Version, Software Version
[Ie4]

Set Broadcast Rate: All activated TPDOs are transmitted every “n” milliseconds. “n” can
be programmed. 5 ms is the minimum. Default: 5 ms.

Set Averaging Filters: Before the data is transmitted by the module (at the broadcast rate), it
can be averaged. There are two averaging filters (alphas): one for everything but
pressure (denoted as “Lambda Alpha”) and one for pressure-related data (denoted as
“Pressure Alpha”). Alphas can range from 0.001 to 1 and are used in the recursive
averaging filter: AvgData; = alpha x Data; + (1-alpha) x AvgDatay.1.

Where: AvgDatay is the transmitted data at time “t”.
AvgDatay._1 is the previously transmitted data.
Datay is the raw data at time “t”.

This formula 1is executed every 5 ms regardless of broadcast rate.
Note that if alpha = 1, there is no averaging and the data taken at time “t” becomes
the average value at time “t” and hence the broadcast value. Default alphas are 0.375.

Enter Fuel Constants: H:C, O:C, and N:C ratios or if the fuel is H2. Defaults: H:C = 1.85,
O:C=0,N:C=0

Calibrate Pressure Sensor: This table contains the voltage versus pressure data for
the pressure sensor (if connected). This data is stored in a memory chip in the
pressure sensor’s connector and is user-reprogrammable.

Calibrate 02, CO2, CO: User enters displayed %02 (TPDO data) and the actual %02 of
the ambient air in which the COCO?2 sensor is hanging. The %02 in ambient air is
determined using an ECM baroCAN device or the “Calc. %02 in Air” feature in the
Configuration Tool. The calibration data for the sensor is stored in a memory chip in
the sensor’s connector and is user-reprogrammable.

Lambda/O2 Delta Tables: These tables are used to modify the calculated Lambda (and
hence AFR, FAR, and PHI) and O2. There are two tables. The first, the Delta O2
Table, allows modification of calculated %02 via a user-entered look-up table. Delta
O2 Table entries will not influence Lambda, AFR, FAR or PHI values. The second,
the Delta Lambda Table, allows modification of calculated Lambda (and hence AFR,
FAR, and PHI) via a user-entered look-up table. The Delta Lambda table will not
influence O2 values.

CO CO2 Trim: This task modifies the calculated CO and CO2. There are two levels of
trim: basic and advanced. Trims are stored in the module, not the sensor and must be
downloaded to every module that is to use them.

Hardware Reset: Equivalent to powering the module down then up again.

Reset TPDOs to Factory Settings: These are the parameters displayed and transmitted.
TPDO stands for Transmit Process Data Object.

Toggle Sensor Settings: Allows power to ceramic sensor to be turned on and off (Default:
On) and enables rapid sensor warm-up scheduling (Default: On (fast)).

Toggle Pressure Compensation: Enable and disable pressure compensation of O2, Lambda,
(AFR, FAR, PHI), CO, and CO2 data. Default: On.

Toggle TPDO CAN ID Auto Set: Enable and disable TPDO CAN ID Auto Set.

Table 1: Task List for CO/CO2CAN Modules



Calibration of the COCQO2 Sensor

Due to the method of operation of the COCO2 sensor, calibration is remarkably simple via
the Calibrate 02, CO2, CO task and is performed using ambient air. Modifications of this
calibration are made using the Lambda/O2 Delta Tables task (for Lambda, AFR, FAR, PHI,
and %02) and the CO CO2 Trim task (for CO and CO?2).

All sensors are calibrated before leaving the factory. It is recommended that they be
calibrated periodically during use. How often can only be determined by your
experimentation. Alternatively, the sensors can be sent to ECM for recalibration.

Calibration information (both factory calibration and user calibration) for the COCO2 sensor
is stored in a memory chip in the sensor’s connector. Therefore, the sensor does not have to
be used with the module it was calibrated with. Once calibrated, the sensor can be sent to
another site to be used. After use, the sensor can be returned to the calibration center for
recalibration thus compensating for any sensor aging. Centralization of calibration in this
way improves measurement consistency and extends useful sensor life.

The Lambda/O2 Delta Tables and CO CO2 Trim are stored in the CO/CO2CAN control
module (not in the sensor’s memory chip). Therefore, they stay in the module in which they
were programmed. If they are modified from the factory default, these modifications must
also be made in all other CO/CO2CAN control modules.

Calibration of the COCOQO2 Sensor

The Calibrate 02, CO2, CO task is used to calibrate the COCO2 sensor. To perform the
calibration:

1. Put the sensor and the pressure sensor (if equipped) in ambient, stationary air. The
pressure during calibration is required if the sensor is to be pressure compensated.

2. The sensor should be left on for at least 20 minutes. Most of the time, you only need
to wait 2 minutes but some sensors, due to condensed material on them or other
reasons, take longer to stabilize.

3. Use ECM’s baroCAN to measure the %02 in air.

4. Alternatively to 3 (above), calculate the %02 in the air. The %02 in air with no
humidity is 20.945. This percentage decreases with increasing humidity. To
calculate the %02 in non-zero humidity air, use the “Calc. %02 in Air” tool in the
Configuration Software. 20.7 is a common number.

5. Select O2 as a TPDO parameter.

6. Select the Calibrate 02, CO2, CO task. Enter the displayed (as the TPDO) O2 and
the actual %02 (as determined in 3 or 4 above), then click on “Span”.
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The Lambda and O2 Delta Tables

The %02 calculated by CO/CO2CAN modules is denoted as “O2R” and is a wet (i.e. water
taken into consideration in %QO2 calculation), at chemical-equilibrium (i.e. not frozen-
equilibrium) %02 measurement (see Appendix C). The Lambda (AFR, FAR, PHI)
calculated by the CO/CO2CAN module is denoted as “LAMR” and matches that calculated

by mass flowrates of air and fuel entering the engine.

Sometimes users would like dry %02 readings, or frozen-equilibrium %02 readings, or dry
frozen-equilibrium readings, or readings that match another instrument. For this purpose, the
Delta O2 Table is used. The Delta O2 Table (found in the task “Lambda/O2 Delta Tables”)
allows the user to add a number (a “delta”) to the “O2R” calculated by the CO/CO2CAN

module giving the “O2” parameter:




02 = O2R + Delta O2 Table value (interpolated from table)*
* except when O2R > 18 for which O2 = O2R, regardless of table data.

A Delta O2 Table can be created, edited, and saved as a text file (.txt) on your PC. The file
must be downloaded into the CO/CO2CAN module for it to be used. Unlike the sensor
calibration information which is stored in a memory chip in the sensor’s connector, the Delta
02 Table is stored in the module.
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Similarly, sometimes users would like Lambda (AFR, FAR, PHI) readings to match other
instruments such as gas-bench analyzer calculated values (ex. via Spindt or Brettschneider) or
company ‘“‘heritage” Lambda measurement techniques. The Delta Lambda Table (found in
the task “Lambda/O2 Delta Tables) allows to user to add a number (a “delta”) to “LAMR”
calculated by the CO/CO2CAN module giving the “LAM” parameter:



LAM = LAMR + Delta Lambda Table value (interpolated from table)

AFR, FAR, and PHI are calculated from “LAM”. A Delta Lambda Table can be created,
edited, and saved as a text file (.txt) on your PC. The file must be downloaded into the
CO/CO2CAN module where it is used. File LA42.TXT (for LSU4.2 sensor) or file
LA49.TXT (for LSU4.9 sensor) can be downloaded to make CO/CO2CAN modules match
default ETAS LA4 data (see Appendix C). Unlike the sensor calibration information (i.e.
zero, span) which is stored in a memory chip in the sensor’s connector, the Delta Lambda
Table is stored in the module.

The CO CO2 Trim

The CO CO2 Trim task modifies the CO and CO2 numbers reported by the CO/CO2CAN
module. This can be used to match the CO/CO2CAN output to another CO and CO2
measurement device (typically a gas analysis bench).

There are two levels of CO CO2 Trims: Basic and Advanced.
€ CO and CO2 Trim (Basic)

In the Basic CO and CO2 trim, the user is allowed to enter gains and offsets to modify the
reported CO and CO2 values and to change the bench gas temperature. The bench gas
temperature is required for an accurate conversion from the wet CO and CO2 values
determined by the CO/CO2CAN to the equivalent dry values (at the bench gas temperature).

The gains and offsets entered act on both the wet and dry CO (COw, COd) and CO2 (CO2w,
CO0O2d) values according to the formulas:

CO (corrected) =ml x CO + bl
CO2 (corrected) = m2 x CO2 + b2
ml and m2 are set at 1 and b1l and b2 are set at 0 as defaults.

The following procedure is recommended to determine the gains (ml, m2) and offsets (b1,
b2) to match another CO and CO2 measurement device.

Perform the Calibrate O2, CO2, CO task

Enter the Bench Temperature

Set ml =1, m2 =1, bl =0, b2 = 0 (Factory Calibration)
Click the “Apply Changes” button

Operate the engine and collect CO and/or CO2 values from CO/CO2CAN and the
other measurement device. Note that gases from an engine, not calibration gases
from tanks, must be used.

6. Use this data to perform a least-squares fit for m1, m2, b1, and b2.

Nk v =



7. Enter these values into the CO CO2 Trim (Basic) screen and click on the “Apply
Changes” button.

8. Note that the O2 CO CO2 calibration results are stored in the sensor’s connector but
the bench temperature and the ml, m2, bl, and b2 values are stored in the
CO/CO2CAN control module. Thus if that sensor is to be used in another module,
the bench temperature and ml, m2, bl, and b2 values determined must be
downloaded into the other module using the Configuration Tool.
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€ CO and CO2 Trim (Advanced)

The advanced CO and CO2 trim consists of modifying the equilibrium temperature table and
the [Poffset value. To do this is a more complex procedure. Contact ECM for more
information.
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Recommended Setup

CO/CO2CAN was designed for engine-out (as opposed to catalyst-out) applications.
However for some cases, the reduction in accuracy when the sensor is located after the
catalyst may be acceptable As-delivered, CO/CO2CAN is programmed for engine-out
applications. For post-catalyst applications, various parameters should be changed for best
results. Below are given the setups recommended for these two applications.

@ Engine-Out Applications

Broadcast rate: 200ms

Averaging Filters: Alpha Lambda=0.375, Alpha Pressure=0.375

Fuel Constants: H:C=1.85, O:C=0.0, N:C=0.0

Delta Lambda Table: use file EngineOutLambdaDelta.txt

Delta O2 Table: none

CO CO2 Trim: Bench Temperature 5 °C, use file EngineOutCOCO2.txt

@ Catalyst-Out Applications

Broadcast rate: 200ms

Averaging Filters: Alpha Lambda=1.0, Alpha Pressure=0.375

Fuel Constants: H:C=2.18, O:C=0.0, N:C=0.0

Delta Lambda Table: use file CatalystOutLambdaDelta.txt

Delta O2 Table: none

CO CO2 Trim: Bench Temperature 5 °C, use file CatalystOutCOCO2.txt

The files EngineOutLambdaDelta.txt, EngineOutCOCQO?2.txt, CatalystOutLambdaDelta.txt,

CatalystOutCOCQO2.txt are located on the supplied CD (or memory stick). The contents of
the files are shown on the next page.
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EngineOutLambdaDelta.txt

0.4500 0.0659
0.5000 0.0536
0.5500 0.0430
0.6000 0.0358
0.6500 0.0306
0.7000 0.0275
0.7500 0.0275
0.8000 0.0272
0.8500 0.0266
0.9000 0.0253
0.9500 0.0175
1.0000 0.0075
1.2500 0.0200
1.5000 0.0364
1.7500 0.0566
2.0000 0.0802
2.2500 0.1075
2.5000 0.1387
2.7500 0.1739
3.0000 0.2135
3.2500 0.2579
3.5000 0.3076
3.7500 0.3629
4.0000 0.4244
4.2500 0.4924
4.5000 0.5675
4.7500 0.6503
5.0000 0.7414
5.2500 0.8415
5.5000 0.9515
5.7500 1.0726

EngineOutCOCO2.txt

0.000000

0.000000

0.800 1960.000
0.900 2005.000
1.000 2200.000
1.100 2005.000
1.200 1960.000

CatalystOutLambdaDelta.txt

0.4500 0.2129
0.5000 0.1867
0.5500 0.1623
0.6000 0.1412
0.6500 0.1221
0.7000 0.1052
0.7500 0.0913
0.8000 0.0771
0.8500 0.0627
0.9000 0.0475
0.9500 0.0258
1.0000 0.0020
1.2500 0.0205
1.5000 0.0445
1.7500 0.0723
2.0000 0.1036
2.2500 0.1385
2.5000 0.1774
2.7500 0.2202
3.0000 0.2674
3.2500 0.3195
3.5000 0.3769
3.7500 0.4398
4.0000 0.5090
4.2500 0.5846
4.5000 0.6673
4.7500 0.7578
5.0000 0.8565
5.2500 0.9643
5.5000 1.0819
5.7500 1.2107

CatalystOutCOCO?2.txt

0.000000
0.000000
0.800 1950.000
1.200 1950.000

11



Selecting What Data is to be Sent (TPDOs)

Data sent from CO/CO2CAN modules is packaged as TPDOs (Transmit Process Data
Object). Each TPDO contains two pieces of data and each module can send up to four
TPDOs. All selected TPDOs will be sent at the broadcast rate. For example, if the broadcast
rate is 5 ms and four TPDOs were selected to be sent, then eight pieces of data would be
transmitted every 5 ms. To avoid slowing down the effective data rate on the CAN bus,
select the number of TPDOs to be sent and the broadcast rate sparingly. For the case of
multiple modules sending multiple TPDOs on the same CAN bus, the minimum (i.e. fastest)
broadcast rate is given by:

Minimum Broadcast rate (ms) = The total number of TPDOs for all modules x 0.3125

For example, if there are eight modules, each sending two TPDOs, the minimum broadcast
rate is 5 ms.

The data transmitted is selected in the “Data” area of the Configuration Tool. Activate the
number of TPDOs to be used by clicking in its box to put in a check mark. Select the data
contained in each TPDO using the pull-down windows. The list of available parameters for
the CO/CO2CAN module is given in Table 2.

Note that in the parameter list, there are three Lambdas: LAMR (Lambda Real), LAM
(Lambda), and LAMC (Lambda C).

LAMR is the Lambda value calculated by the module.

LAM is the Lambda value calculated by the module and modified by the Delta Lambda
Table according to the relationship:

LAM = LAMR + Delta Lambda Table value (interpolated from table)
The modified LAM (Lambda) will also influence AFR, FAR, and PHI.
Similarly for O2R and O2:
02 = O2R + Delta O2 Table value (interpolated from table)*
* except when O2R > 18 for which O2 = O2R, regardless of table data.

LAMC is LAM at synchronized to the CO and CO2 measurements. It is used in the CO
CO2 Trim (Advanced).
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Parameter

Name

Displayed Full Parameter Name Parameter Description

O2R %02real %02 before addition of Delta O2 Table

IP1 Ipl (A) Pressure-compensated Lambda sensor pumping current

RPVS RPVS (Ohms) COCO2 sensor internal VS cell resistance x 1000

VHCM VH Commanded (V) Desired heater voltage commanded by the module

VS VS (V) COCO?2 sensor internal VS cell voltage

VP1P VP+ (V) COCO?2 sensor pumping voltage

VSW Vsw (V) Supply voltage measured at the module

VH VH Measured (V) Actual heater voltage at the module

TEMP Circuit Board Temp (°C) Temperature of the module circuit board

IPIR Iplraw (bits) COCO?2 sensor pumping current (unsigned integer format)
PR16 Praw16 (bits) 16 bit Pressure sensor output voltage (unsigned integer format)
URFL Error bit flags (bits) Module error flags (unsigned long format)

URCd ECM CANOpen Error Code | ECM CANOpen Error Code

PR10 Praw10 (bits) 10 bit Pressure sensor output voltage (unsigned integer format)
PCF Pressure Correction Factor COCO?2 sensor pressure compensation correction factor x 10000
PCFE ECM diagnostic parameter

O2E ECM diagnostic parameter

IP1E ECM diagnostic parameter

PE ECM diagnostic parameter

P P (mmHg) Pressure sensor measured pressure (absolute) in mmHg
LAMR LAMBDA real Lambda before addition of Delta Lambda Table

AFR Air-Fuel Ratio Air-Fuel ratio calculated using LAMBDA

PHI PHI PHI = 1/LAMBDA

FAR FAR*10000 FAR = (1/AFR) * 10000

LAM LAMBDA Lambda after addition of Delta Lambda Table

02 02 (%) %02 after addition of Delta O2 Table

IP1X Ip1 non-Pcomp (A) Non-pressure compensated COCO2 sensor pumping current
PVLT P (V) Raw volts from pressure sensor

PKPA P (kPa) Pressure sensor measured pressure (absolute) in kPa
PBAR P (bar) Pressure sensor measured pressure (absolute) in bar

PPSI P (psi) Pressure sensor measured pressure (absolute) in psi

PERF Error bit flags (bits) Pressure sensor error flags (unsigned long format)

PERC CANopen error code Pressure sensor error code

CO2w %CO2 wet %CO?2 (wet) after effect of CO CO2 Trim

COw %CO wet %CO (wet) after effect of CO CO2 Trim

CO2d %CO2 dry %CO2 (dry) after using Bench Temperature and CO CO2 Trim
COd %CO dry %CO (dry) after using Bench Temperature and CO CO2 Trim
LAMC Lambda LAMBDA synchronized to the CO and CO2 measurements
EQT T (°K) Equilibrium Temperature (°K)

Table 2: CO/CO2CAN Parameter List
(Highlighted parameters are the ones most commonly used.)
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Producing a .dbc File

A .dbc file describes to the device receiving data from one or more ECM *CAN modules
what is in the data packages. For each module, the packages will contain data for the
parameters selected in the activated TPDOs and an error code. The Configuration Software
has a tool called “Generate .dbc...” that will generate a .dbc file for all the ECM *CAN
modules on a CAN bus. Make sure that each module is configured as desired and that all
modules are on the bus before the “Generate .dbc...” button is pushed. Data package
information from all the modules is stored in the one .dbc file produced.

Programs importing the .dbc file and applying it to the CAN data transmitted by the modules
will see data, etc identified as follows:

Data: name_nid[units]
where: name = parameter name. See Table 2 for CO/CO2CAN parameters.
nid = node id of module in hex
units = units of parameter
for example: O2_0X01[%] which is the %02 measured by module with nid 0X01

Error code: ECM_Error_Code_nid

where nid = node id of module hex
error code is in hex and given in Table 3

for example: ECM_Error Code 0x11
Auxiliary: ECM_Auxiliary _time|[sec]
where: time = decrementing countdown to module activation in hex

for example: ECM_Auxiliary 0X12[sec]
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PRESSURE |LAMBDA
ERROR ERROR LED ACTION
CODE CODE (Lambda Only) DESCRIPTION OF ERRORS
0x0000 0x0000 Grn ON All OK, (green led constantly on)
n/a 0x0001 Flash Grn 10Hz Lambda sensor warm-up period
n/a 0x0002 Grn/Both/Red 2s |[Power on reset/ Init hardware
n/a 0x0011 Pulse Red 1x/2s |16b ADC failed to init
n/a 0x0012 Pulse Red 1x/2s |+Vsw shorted
0x0013 0x0013 Red ON Sensor turned off (red led constantly on)
0x0014 0x0014 Pulse Red 1x/2s |Sensor not present/ HTR open
n/a 0x0015 Pulse Red 1x/2s |HTR shorted
0x0021 0x0021 Pulse Red 2x/2s |lwire bus shorted
0x0022 0x0022 Pulse Red 2x/2s |No lwire present
0x0023 0x0023 Pulse Red 2x/2s |CRC1l6 error
0x0024 0x0024 Pulse Red 2x/2s |Invalid lwire parameter (sensor type)
0x0025 0x0025 Pulse Red 2x/2s |l-wire data format not compatible (old rev)
n/a 0x0031 Pulse Red 3x/2s |+Vsw < 6 for > Tsec
n/a 0x0032 Pulse Red 3x/2s |[+Vsw > 32V
n/a 0x0041 Pulse Red 4x/2s |VS too high
n/a 0x0051 Pulse Red 5x/2s |RVS too high
n/a 0x0052 Pulse Red 5x/2s | (VHcommanded - VHactual) > 0.5V for > 10sec
n/a 0x0061 Pulse Red 6x/2s |VP+ > 6V
n/a 0x0062 Pulse Red 6x/2s |VP+ < 2V
n/a 0x0063 Pulse Red 6x/2s
n/a 0x0064 Pulse Red 6x/2s [0.25V > VS+ > 0.75V
0x0065 Pulse Red 6x/2s |User data (span) in lwire corrupted (user
n/a must set new span)
n/a 0x00A1 n/a Invalid software state
n/a 0x00B1 n/a CAN overrun
n/a 0x00B2 n/a CAN passive mode
n/a 0x00B3 n/a CAN heartbeat error
n/a 0x00B4 n/a CAN recover bus off
n/a 0x00B5 n/a CAN Tx CanId collision
n/a 0x00B6 n/a Serial overrun
n/a 0x00B7 n/a Can overrun Lss
n/a 0x00B8 n/a Can overrun Sdo
n/a 0x00B9 n/a Can overrun Rx
n/a 0x00BA n/a Can overrun ECT5
n/a 0x00FF Both ON Module powering down within 500ms
n/a ECM AUX n/a Lambda sensor warm-up count down in seconds

(active during ECM Error Code 0x0001)

Table 3: CO/CO2CAN Error Codes List (in Hexidecimal)
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Using the dashCAN* Display

The dashCAN display (see cover and below) is a small (105 mm x 63 mm x 63 mm), two-
channel remote display for CAN networks containing ECM *CAN modules. dashCAN+ is a
slightly larger display (105 mm x 63 mm x 165 mm) with the addition of six programmable
analog outputs. dashCAN* (i.e. dashCAN or dashCAN+) comes with a two meter cable and
a “T” (P/N 09-05). Simply attach dashCAN* to the CAN bus and any two parameters being
transmitted from ECM *CAN modules can be displayed and any six parameters can be
converted to analog outs (dashCAN+ only). dashCAN* can display parameters from the
same module or two different modules. Multiple dashCAN* displays can be attached to the
CAN bus.

dashCAN* has two modes of operation: RUN (when measurements are displayed) and SYS
(where dashCAN* is set-up). The SYS key toggles between the modes.

While in RUN mode:

i. If the T button is pressed, the displays will show the serial numbers of the modules
assigned to the displays.

ii. If the ¥ button is pressed, the displays will show the parameter names assigned to the
displays. See Table 2.

iii. If the ENT button is pressed, the displays will show the units of the parameters.
“PCTG” is %. “dIM” means dimensionless (ex. for AFR, FAR, PHI, Lambda).

In RUN mode, four things other than data can be displayed:

1. “ERR” and “####”° where “### is an error code. See Table 3.

3

ii. “....” which means that a module has not been assigned to that display.
iil. “----“ which means that dashCAN* has an internal problem.
iv. “XXXX” which means that dashCAN* is not receiving any data from the module

assigned to that display.

When first entering SYS mode, either “MOd” will be on the upper display or “LOCK” will
be on the lower display. If “MOd” is displayed, the T and ¥ keys will roli through the setup
options (see Table 4). First the options for the upper channel are shown on the upper display,
followed by identical options for the lower channel on the lower display, ending with the
global CONF (Configuration) setup. Pressing the ENT key will select the displayed setup
option and allow its programming.

If “LOCK” is displayed, the dashCAN has been locked and its setup cannot be changed until
it is unlocked. Appendix F describes how to LOCK and unlock dashCAN*.

dashCAN
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Setup Option Level 1 Function

MOd Select module s/n. Default is NONE.

RATE Set parameter averaging rate. Range 0.001 to 1.000
Default is 1.000

AOUT (dashCAN+ only)
A1 (upper channel) Program analog output 1
A2 (upper channel) Program analog output 2
A3 (upper channel) Program analog output 3
A4 (upper channel) Program analog output 4
AS (upper channel) Program analog output 5
A6 (upper channel) Program analog output 6

dISP Select parameter. Note: Parameters available are
those contained in TPDOs programmed using
Configuration Software.

CONF LEdS Set display intensity. Default is 3333.
LOCK Lock and Unlock Display for Programming

MOd, RATE, AOUT, and dISP appear on the upper display for the upper channel and on the
lower display for the lower channel. CONF just appears on the lower display and is for
global dashCAN* setup. All entries must be followed by pressing the ENT key.

Table 5: Menu Tree for dashCAN*

MOd (Module) Setup Option

In MOd setup, the serial number of the module assigned to the upper or lower channel is
entered. The serial number is written on a label on the module. The module assigned to the
upper channel will send information to the upper display and the module assigned to the
lower channel will send information to the lower display. The same module can be assigned
to both channels or different modules can be assigned to each channel.

After entering MOd (i.e. press ENT when “MOd” is displayed), the serial numbers of the
available modules will be displayed. Select using T and { followed by the ENT key.

RATE Setup Option

Data is transmitted from modules at the broadcast rate and the programmed averaging that
was programmed using the Configuration Software. This transmitted data can then be further
averaged before being displayed on the displays. Separate averaging can be programmed for
the upper display and the lower display.

The averaging is programmed with values from 0.001 (heavy averaging) to 1.000 (no
averaging). The default is 1.000. The averaging is performed as follows:

DisplayedValue; = a x Parameter; + (1 — a) x DisplayedValue,
where:

DisplayedValue, = the new displayed value
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o = The user-programmable averaging.
Range: 0.001 (heavy averaging) to 1.000 (no averaging).

Parameter; = the latest value transmitted by the module
DisplayedValue, ; = the previous displayed value

The selected display averaging does not affect the module’s CAN transmission rate or
averaging.

AOUT Setup Option (dashCAN+ Only)

The dashCAN+ display head has six 0 to 5V programmable analog outputs. The analog
outputs are updated at the module Broadcast Rate (see Table 1). This can be as fast as every
5 ms. Keep in mind that the data may be averaged (see Set Averaging Filters in Table 1)
before being broadcast.

Parameter information from the module assigned to the upper channel can be sent to analog
outputs 1, 2, and 3. Parameter information from the module assigned to the lower channel
can be sent to analog outputs 4, 5, and 6.

Here is an example of setting analog output 2 (i.e. A2):

1. Press the SYS key so that “MOd” is displayed.
2. Press the  key until “AOUT” is on the top display. Then press the ENT key.
3. Press the 4 key until “A2” (analog output 2) is on the display. Then press the ENT

key.

4. Press the T and ¥ key until the parameter (see Table 2) that will drive A2 is displayed.
Then press the ENT key.

5. When OV is displayed, press ENT. Using the T, ¥, and ENT keys, set the parameter
value that you want to result in an analog output voltage of OV on analog output 2.
The first time you do this, it may be a little tricky. You are setting one digit at a time
and for some numbers, the display will shift to the left so you can set the right-most
digits. If you get into trouble when programming, press the SYS key twice to exit
and re-enter setup to try again.

6. When 5V is displayed, press ENT. Using the T, J, and ENT keys, set the parameter
value that you want to result in an analog output voltage of 5V on analog output 2.

7. When “AOUT” is displayed, press SYS to return to RUN mode.

If in the above example analog output 4 was being programmed, AOUT, A4, 0V, 5V, and
your entries will be shown on the bottom display.

dISP (Display) Setup Option

In dISP setup, the parameters to be displayed are selected. Only parameters selected in active
TBDOs by the Configuration Software can be displayed.

Here is an example of setting the parameter to be displayed on the upper display:

1. Press the SYS key so that “MOd” is displayed.
2. Press the  key until “dISP” is on the top display. Then press the ENT key.
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3. Press the ¥ key until desired parameter name is displayed. See Table 2. Then press
the ENT key.
4. Press SYS to return to RUN mode.

CONF (Configure) Setup Option

CONTF setup appears at the end of the setup list on the lower display. To enter CONF, press
the SYS key so that “MOd” appears on the upper display, press the | key until “CONF”
appears on the bottom display, and then press the ENT key. CONF is for global dashCAN
setup.

¢ LEdS

The display intensity is [%rogrammable. Press the ENT key when “LEdS” appears on the
lower display, press the T or | keys until the display intensity is suitable, press ENT, and
press SYS to return to RUN mode.

¢ LOCK

“LOCK” locks the MOd, RATE, dISP, and LEdS setup. This stops unauthorized
modification of the display. Refer to Appendix F for more information.
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Appendix A: CO/CO2CAN Kit Contents
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The CO/CO2CAN Kit consists of:

Description

1. CO/CO2CAN Control Module
2. COCO2 Sensor
3. Lambda Extension Cable
4. Flexi-Eurofast Cable

5.
6
7
8
9.
1

Eurofast “T”

. Eurofast Terminating Resistor

. 2m Eurofast 12mm Cable

. DC Power Cable, DBI9F, Banana

Lambda Sensor Boss & Plug (18mm x 1.5mm)
0. Manuals and Configuration software CD

P/N
02-011
05-12
10-02 (1m)
09-04 (0.3m)
09-05
09-06
09-02
11-02
12-02
13-01

Optional Pressure Compensation (add /P to kit part number):

1.

2.
3.

4.

Pressure Sensor, 0-75 psia, 517 kPa

Pressure Extension Cable
Pressure Sensor Tubing

Module Y Cable

Optional Cables:

1.
2.
3. DC Power Cable, DBIF, Spades

Optional Power Supplies:

1.

Lambda Cable
Pressure Cable

AC/DC Power Supply, Universal 24VDC @ 4.2A
(requires p/n 11-17 Deutsch DTM3M to DBYF)
2. Vboost Supply, 10-14VDC to 24VDC @ 14.5A

07-08 (USA) or
07-09 (metric)
10-35 (1m)
12-08 (USA) or
12-11 (metric)
10-34

10-03 (2m)
10-36 (2m)
11-01

04-01

04-02

Quantity

—t ek e e ek e ek e ek
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Appendix B: Module Stand-alone Mode and EIB Mode

CAN data from ECM *CAN modules can either be taken directly from the modules
themselves or from the CAN port of display heads connected to the modules. When data is
taken directly from one or more modules, each module must in Stand-alone mode. When
data is taken from one or more display heads of an EGR 5210, Lambda 5220, or EGR 5230
analyzer, each module must be in EIB mode.

Therefore, the module must be properly configured in Stand-alone mode or EIB mode
depending on how it will be used. When *CAN modules are sold alone, they are delivered in
Stand-alone mode. When *CAN modules are sold as part of a NOx 5210, Lambda 5220, or
EGR 5230 analyzer, they are delivered in EIB mode.

To convert from one mode to the other requires software reprogramming of the module
followed by the installation (to set to Stand-alone) or removal (to set to EIB) of a jumper
inside the module.

¢ To convert a module from EIB to Stand-alone Mode

1. Take the nut off the end of the module. Use an 18mm socket without the wrench.

22



3. Slide the PCB out. Install a jumper on JP4.

JP4

=
&
g
=
=
>
*

™

5. Slide the PCB into the enclosure until the two tangs “click”.

6. Put the nut on and tighten ONLY 2 turn from where it is seated. If this nut is
tightened too much, the connector will crack and the enclosure will not be sealed.

7. Connect the module to a power supply and a PC (via a CAN communication adapter)
using the cabling shown. A sensor does not have to be connected to the module. Note
that only one module is connected and a display head is not involved.
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P/N 11-02, DC Power Cable, To power
Module Serial DB9F, Banana Plugs (shown), or
Number P/N 11-01, DC Power Cable,

DB9F, Spades

Nvoepquel DT

et
eInpoj

k‘T’, JS‘“
“ To CAN adapter

Resistor
On PC

Figure Al: Module prepared for Reprogramming

8. Start the Configuration Tool (software). Click on the “Module” tab.
Select the CAN adapter being used. Then start the communication.

ez FCM Configuration Tool v3.0 Q\i@

ECM Configuration Tool

s i| Display Heads ]

CAN Adapter: IVectOICAN L' ICANcardX Channel 1 L’ START I Status: ]Port Closed .

Configuration ~Toals

NID Prod.# Rev.# Serall LogData...
Module: I 3 Generate .dbc...
Task: I Lj

Calculate %202 in Air

Manual Communication ]

Set Module Mode
ElB Stand-4lone |

Note: This function can only be
used with one module on the bus.

» DS':t'lo' S/N TPDO1 | TPDD2 | TPDO3 [ TPDO4 [
Eror  Aux. I LI I LI - -
r [0 [0 b b
CaNopen State I LJ I ._'_] | :I' I :"
l o o b b

www.ecm-co.com - 408-734-3433 - Los Altos, CA, USA - (c) 2006




9. Click on the “Set to Stand-Alone Mode”. Wait for “Done” Message.

Stop communication and exit program. The module is in Stand-alone mode.

¢ To convert a module from Stand-alone Mode to EIB Mode

1. Use the Configuration Tool (software) to “Set to EIB Mode”.
2. Remove the jumper on JP4 in the lambda module.
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Appendix C: Interpreting O2 and Lambda (AFR, FAR,
PHI) Data from CO/CO2CAN Modules

¢ Comparing to Spindt and Brettschneider Calculations

CO/CO2CAN calculates Lambda, AFR, FAR, and PHI numbers comparable to those
determined by mass flowrates of air and fuel into the engine. Lambda calculations based on
gas-bench analyzer data do not always give these same values. This fact is well documented
in the literature.

However, some organizations prefer to call their specific (and often unique) Spindt or
Brettschneider calculations of Lambda the “true” values. To satisfy such needs, ECM has
provided the Delta Lambda Table and Delta O2 Table features.

« Before and After Catalyst Measurements

The COCO?2 sensors operate on a diffusion mechanism. Molecules leaving the combustion
chamber (02, CO, CO2, H20, H2, HC, NOx, N2, etc) diffuse into the sensor where
oxidation, oxygen liberating, and oxygen pumping occurs. O2, Lambda, AFR, FAR, and
PHI are determined from the oxygen pumping rate and assumptions about the combustion
products entering the sensor. One such assumption is that the exhaust exists in a certain
chemical composition. Exhaust gases entering and exiting a catalytic converter have
different chemical compositions. CO/CO2CAN assumes that the gases are engine-out (not
catalyst-out). Therefore measurements made at the exit of a catalyst will require a Delta O2
Table and a Delta Lambda Table correction to be accurate. This is sometimes called “H2
Correction”.

« Wet versus Dry Measurements

Percentages of components in the exhaust of an engine are expressed as percentages
(molecule count or volume) or ppm. The numerator used to calculate these percentages and
ppm contains the molecule-of-interest count and the denominator contains the total number
of molecules in the sample containing the “count”. One of the molecules produced by the
process of combustion, and in significant quantities (ex. 15%), 1s H20.

Percentages and ppm calculated by CO/CO2CAN consider the water molecules in the
denominator and are called “wet” percentages (or ppm). This only makes sense since the
sensors are directly in the exhaust where the H20 is present. In contrast to this, classical gas-
bench analyzers almost always remove the water before the gas sample reaches the analyzers.
This is because the analyzers cannot tolerate condensed water. Therefore, gas-bench
analyzers will report O2 percentages and NOx ppms as “dry” percentages (or ppm) (i.e.
without H20 molecules counted in the denominator).

Therefore, when comparing “wet” (or “true”’) O2 and NOx data from CO/CO2CAN to “dry”
02 and NOx data from gas-bench analyzers, realize that the dry percentages and ppm will be
5% to 10% higher than the wet (or true) readings. The wet to dry conversion for %02 is a
function of %02 (or Lambda) and can be performed by using a Delta O2 Table.

26




« Equilibrium versus Non-Equilibrium O2

Gases exiting the combustion chamber of an Otto or Diesel cycle engine are not at chemical
equilibrium. As the exhaust valve opens, the gas temperature and pressure drop so quickly
that many chemical reactions still occurring are slowed down or “frozen” at non-equilibrium
values (for the specific temperature and pressure they are at). This degree of chemical non-
equilibrium is affected by exhaust valve timing and ignition timing. The COCO2 sensor is
hot and highly catalytic and will bring the exhaust they sample closer to chemical
equilibrium. The result of this is that the %02 measured by the COCO2 sensor will be close
to equilibrium levels (typically 0.5% lower than actual engine-out). For example, at Lambda
= 1 conditions, the %02 reported by the COCO2 sensor will be 0 (the chemical equilibrium
%02 value) as opposed to the actual frozen equilibrium %02 value of approximately 0.5%.
Keep this in mind when comparing gas-bench measured %02 with COCO2 sensor-measured
02. This difference can be corrected for by a Delta O2 Table.

& Pressure

The main source of error influencing O2 (Lambda, AFR, FAR, PHI) measurements is
exhaust pressure. This error is more significant the further from Lambda = 1 the exhaust
stoichiometry gets. Pressure compensation (P-comp) data is stored in the memory chip of
every Lambda and NOx sensor. All that is required is the addition of a calibrated pressure
sensor to the module activate the pressure compensation. It is highly recommended that
pressure compensation be used with any lean burn, HCCI, or diesel engine.

o Comparing to an ETAS LA4 Meter

Many ETAS meters with new sensors will not correctly show the %02 when the sensor is
held in air. The actual %02 in air depends on the humidity and will be almost always less
than 20.945%. Since the measurement of %02 is the fundamental mechanism by which the
wideband sensor determines Lambda, the effect that this error has on meter accuracy is
obvious. This %02 measurement error will have a negligible effect at Lambda=1 but the
effect on Lambda will increase the further Lambda gets from Lambda=1.

All lambda meters should read the correct %02 when the sensor is held in air. Due to sensor
aging and changes in ambient pressure (due to weather and altitude changes), this may not be
the case. However, CO/CO2CAN’s “Span O2” feature allows to user to restore the system’s
accuracy.

The O2 span is performed by holding the sensor in air and entering the actual %02 in air.
However, if you are comparing a CO/CO2CAN to an ETAS meter and you want the
CO/CO2CAN to match the ETAS meter, then you must span the CO/CO2CAN to whatever
the ETAS meter says the %02 is in air — even if it is wrong.

Therefore, if you want a CO/CO2CAN to match an ETAS meter, whether or not the ETAS
meter reads the correct %02 in air, do the following:

1. Make certain that the “LA42. TXT” (for the LSU4.2 sensor) or “LA49.TXT” (for the
LSU4.9 sensor) curve is downloaded to the CO/CO2CAN module as the “Delta
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Lambda Table”. This is for the case of matching the “Default Curve” in the ETAS
meter. Other curves are available and the user can create his own curve.

2. Turn on the ETAS meter and hold the sensor in air. Read the %02 on the ETAS
meter. This value should be 20.945 or less since 20.945 is pure air with no humidity.
We have seen values of over 22%.

3. 02 span the CO/CO2CAN to the %02 given on the ETAS meter even if it is wrong.

This procedure is to be used only if you want the CO/CO2CAN to match a specific ETAS
meter and sensor combination. Normally, the CO/CO2CAN are spanned to the correct %02
in air.
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Appendix D: Setting Up ETAS INCA for ECM Modules

Hardware Setup: Using ETAS ES591.1

1.

Connect the power port to a power source between 6V and 32V.
Connect the Ethernet port directly to the Ethernet port on your PC. This port does not
use an internet/intranet connection like a router.

Connect either the CAN1 or CAN2 port to a CAN network (i.e. ECM modules or
display heads).

Software Setup: Using ETAS INCA V5.4.1, Hotfix 22, GM Install

1.

Double click the INCA V5.4 icon to open the software.

2. Create a new Database. In the Database menu, select New. Give your database a

name (i.e. a folder name). In INCA, a Database means the current working directory.
Each project is created in a unique directory. When INCA is opened, it will default to
the last Database that was used.

Add a new Workspace. Right click on the “DEFAULT” folder icon, select Add >
Workspace. You can rename it to whatever you want.

W INCA V5.4.1/22

Database Edit  Wiew Options  Utilities 7
O E X - &0 ERER e Y

1 Items

4.

m Add 3 Add top Folder
add folder Insert
Delete Delste Experiment Chrl+T
ECU-Praject (azl)... Chrl+P
Copy Ctr+C CDOM-Configuration Alb+C
Measure-Catalog. ..
Rename Fz ECU Documentation, ..
Can-DB...
List of CAN Messages
Import Chrl+i Read CAMN Message Log File. ..
Export Chrl+E
Write 3

Conwvert Experiment 3

Add a new dbc file for your project. Right click on the workspace you created in
step 3, select Add > Can-DB. Browse to your dbc file and click open. In this
example, we are using a file named test8mod.dbc. An INCA log window will pop up.
You can ignore this.
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3 INCA V5.4.1/22

Database Edit  Wiew Options Utilities Experiment Project Device 7

D= E & By X (B8 R ESRNEIN 5 m__
IHCA
Lo " INCA V5.4.1/22*
[l {ZdDEFALLT Database Edit Yiew Options  Utilities
T S 1o o = 3 g
A £ . 2
Add Folder Insett D L= E ':"% x "& |
Workspace Chriw 1 Items
Delete Delete Experiment Chrl+T —
E”t E:r::z ECU-Project (A2D. . Crlep =l {ADEFAULT
=Py ! CDM-Configuration Al+C — od
- L4
Measure Catalog.... T Workspace
Rename Fz ECU Documentation, .,
Edit Return
| List of CAN Messages
Lmport Cerk Read CAN Message Log File. ..
Export Chrl+E
Wrike 3
Convert Experiment »

5. Configure the hardware. Click on the icon for the workspace you created in step 3.
Open the Hardware Configuration icon under the section text “6. Hardware”. A
hardware configuration window will open.

e INCA V5.4,1/22* | 'Eﬁl[il

Database Edit  ‘iew Options Utlities Experiment  Project Device 7
OE $#BEX i@~ &8 SR80 8 vl
1 Ikems 4 Expetiment

=1 ‘I DEFALLT Al 88X

I: B ct5mod |

S Project/device

u

=

[ Hardware/

Workspace L

3 Item comment Caonfigure hardware

(4/1/2006 3:27:24 PM 528 55

|

Filter: none | DB: <test: User: <MainUser >




6. Select the hardware. In the hardware configuration window, right click the “HWK
Workspace™ listed under the section text “l1. Hardware Devices”, and select Insert.
Select the ETAS device you wish to use. In this example, we are using an ETAS
ES591.1. Expand the selection tree by clicking the “+” next to the hardware device
model. Expand the CAN selection and select CAN-Monitoring. Click OK.

. Hardware: >Workspace= Experiment: >Default<

File Hardware Device Channels Wiew 7

R ™
IE Add hardware device

1 Hardware devices
Hwk Workspace

Select the new modules you want to add to
the hardware configuration.

Available HYW devices

Cancel

= B ES6a0/ES5a0/ES51
= R can
CAN-Manitaring;
= amian
= Can-Output
e
oo
= kwipzo00
= ups
—E T k-Line...

et

[l = T L

1

| £

Multiplicity:
(Inactive)

—

7. Associate the dbc. When you clicked OK in the last step, another window will pop
up that will allow you to select a dbc that you have added to your workspace from
step 4. Expand the selection tree, select your dbc file, and click OK.

—:/Hardware: >Workspace= Experiment: >Default<

File Hardware Device Channels Wiew 7

1 Hardware devices

Select project and working data for, CAN-Monitoring:1

4 Info

Huk, Workspace Bt itz
I?_ ES600/ESSI0(ESSSL 1 1 Ttems
l_SN: Mot assigned —
CaN:1 = {ZDEFALLT
. L .

@ Can-Manitaring:

>

| €

|Can_DB... - testamod

3 Ikem comment

(4/1/2008 3:36:10 PM 937 68)

Cancel sty e

o |

Fnent F
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8. Initialize hardware. The hardware is currently stopped, as indicated by the red stop
sign icon next to the selected hardware. You must initialize it before you can use it to
collect data. Click on the Initialize Hardware button on the upper tool bar and wait
for the hardware to complete its initialization. Another window will pop up to
confirm the device to connect to. Click OK.

—‘/Hardware: >Workspace< Experiment: >D

Fle Hardware Device Channels Wiew ?

wOo = AdE T

Initialize hardware F3
TSP dreE

ES690/ESS90/ESS91:1
S Kok assigned

L Chak:1

20 -Monikoring: 1

'’ Connect devices...

Systems

INCA Hardware Configuration Detected Hardware o] Connected 0]

11 Typet
ES690/ESSI0/ESSILL
Connect Shi: Mot assigned SM:120411
Discornect
Disconnect all
Fiter
[ e wo | % Cancel
HostInterfaceType System type
@ all connected

9. Open an Experiment Environment. Click on the Experiment Environment button
on the upper tool bar to open an Experiment Environment. The Experiment
Environment is where you can setup the monitoring of the CAN bus. By default, the
Experiment Environment will be blank. You must select the variables from the dbc
file that you wish to monitor. Click on the Select Variables icon in the left hand tool
bar of the Experiment Environment.

Experiment: >Mew experi

Expetiment View Yariables Mea:

=
—:/Hardware: >Workspace= Experiment: =Default= @
File Hardware Device Channels Wew 7 B
MO B AdE ) b
1 Hardware devices ,{fxperiment enviranment CtrI+F5| o
HuE Workspace T
Ii ES690/ES590/ES591:1 5%
;120013
L~ Canl {:Select wariables... Shift+F4
€ Can-Moritaring: 1 =



10. Select and Configure Variables. Select the variables that you wish to monitor in the
Experiment Environment. These variables names are based on the data found in the
dbc file. Click Configure.

" Select variables =Measure variables >

Filtet ‘“ariables Selected 7

1 Devices E 3 Yariables 4 Selected alveady used
= |D:E O Cam-Monitoring: 1 A *0 AFR_0x01  {TPDOZ_Ox01-FF AFR_0x01
—— B2 O Emergency_0x01 &0 Canopen_Frror_Code_0x01  {Emergency_0x01-F- CANopen_Errar_Code_0x01
—— B2 O Emergency_0x02 *C0 CANopen_Error_Reg_0x01  {Emergency_0x01-fr CANopen_Error_Reg_0x01
— B0 Emergency_0x03 *T0 CANopenState_0x01 {Heartbeat_0x01-f} CANopenState_Dx01
—— B2 0 Emergency_0x10 £ 0 ECM_pudliary_0x01  {Emergency_0x01-F- ECM_Auxiliary_0x01
—— £20 Emergency_nxzo *£'0 ECM_Error_Code_0x01 {Emergency_0xO1-f} ECM_Errar_Code_0x01
— Bg O Emergency_Ox21 B0 FAR_Ox0L  {TPDOZ_Ox01-f} FAR_0x01
—— B2 O Emergency_0x22 0 LAM_0x01  {TPDO1_Ox01-F- LAM_0x01
—— B0 Emergency_0x23 U0 0z_ox0l {TPDO1_Dx01-fr 02 _Meel
— Bg O Heartbeat_0x01
— Eg O  Heartbeat_0x02
— Eg O Heartbeat_0x03
— Eg O Heartbeat_0x10
— Eg O  Heartbeat_0x20
— B2 O Heartbeat 0xz1 ™

Mo raster pre-selection possible!

Configure | Use defaults | Cancel

11. Another window will pop up to configure each selected variable. You can configure,
for each variable, whether to record or simply display the data, how the data will be
displayed (graphs, charts, gauges, numeric, etc.). When complete, click OK. We
have left all configurations at default for this example.

~ Configure Selected Variables

Components  Filker  Parameters

2 Parameters

Parameter
Mame Stabe dT =7 ‘window Display type Device

AFR_0x01 Dispfrec = .layer_l=><Meas. > Murn ZAM-Monitoring: 1
CAMopen_Error_Code Dispfrec = .layer_lz=<Meas.> Mum CAN-Monitoring: 1
CAMopen_Error_Reg. Dispfrec = .layer_lz=<Meas.> Mum CAN-Monitoring: 1
CANopenState_0x01 Dispfrec = .layer_l>=<Meas.> Mum CAN-Monitoring: 1
ECM_Auxiliary_0x01  Dispfrec = .layer_l>=<Meas.> Mum CAN-Monitoring: 1
ECM_Errar_tCode_0x( Disp/rec = .layer_lz=<Meas.> Mum CAN-Monitoring: 1
FAR_Ox01 Dispfrec = .layer_lz=<Meas.> Mum CAN-Monitoring: 1
L&M_0x01 Disp/rec = .layer_l>r=Meas.> Mum CAN-Monitoring: 1
OZ_0x01 Dispfrec = layer_l=>»<Meas.> um « | CAN-Monitoring: 1

Eiar

Alert

i3auge

MsgBo

Eit.

Active Component: <Experiment:=  |Active Filter: <all Types= |Active Parameter: <OZ_0x01=

QK Cancel

12. A new sub-window will be added to the Experiment Environment. You do not need
to select all the variables you want to monitor all at once. You can click on the Select
Variables icon again at a later time to add more variables. Each set of variables you
add will be placed in a new sub-window unless it is configured to join an existing
sub-window. In this example, we have created a sub-window for each of the eight
modules in the dbc file.
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Experiment: >NewExp= Hardware: >Workspace<

Experiment Yiew Varjables Measurement Hardware Dataset Components tindow 2

D | re—" B[] 2] Measure window [+ 8| |8 Measure windo =
z 02_0x01 [ - 126 Q2R _0x10 I - [ 126] O2_0x22 ] - 13%]
— | AFR_Dn01 I -In CAMopen_Error_Reg_0x10 | [thex) | AFR_Dx22 ] -lo
g CAMopen_Error_Code_0x01 H -H[hex] CAMNopen_Error_Code_Ox10 [l -ﬂ[hex] CANDpen_Errcr_Code_Dx22|l —H[hex]
; CANopen_Error_Reg_0x01 H = H [hex] CAMNopenState_0x10 [l -|| [hex] CAMopen_Error_Reg_0x22 || —H [hex]
. | SANorenstate o1 | -lihed | ECM_Awdliary_0x10 [ -|ihed | CANopenState_0xz2 I - thex
| Eoh Adliany Dl | “|ihed | ECM Error_Code_0x10 [ Jihed | ECM_Ausdliary_0x22 I - thex
-;E ECM_Error_Code_ 0w | Jiheq fiP1_oxi0 [ |ima] | ECM Error_Cods_0x22 I - thex
é FAR_ b1 | o P2 010 [ [ wal FAR_ =22 I o
,? LAK_[01 [ o WO _0x10 I Jippm) [fLar mx22 I B [
» | Me 8 do | | Me e do | B a d |
e | O2_0x02 I - 12%] 0z_0x20 I - 12] AFR_0x23 I -|n
Il | AFR D2 | -To AFR_ 0520 [ -To CARNopen_Error_Code_0x23 | -|thex
2] CAMNopen_Error_Code_0x02 H fﬂ[hex] CAMopen_Error_Code_0x20 [l fﬂ[hex] CAMopen_Error_Reg_0x23 |] ﬂ[hex]
g CAMNopen_Error_Reg_0x02 H = H [hex] CAMopen_Error_Reg_0x20 [l = H [hex] CAMNopenState_[x23 |] || [hex]
g | SAnepenSiate 0x02 | “Jihexd | CANopenState_0x20 [ Jihex) | ECM Ausiliary_0x23 [ | thex
7 | ECM_Awidliary_0x02 | Jiheq | ECM Ausiliary_0x20 [ ~|lhex) | ECM Error_Code 0x23 [ | ihe
ECM_Error_Code_0x12 [ -|ihexg | ECM_Errer_Ceds_0x20 [ e | FAR_0x23 [ o
FAR_0x02 I -Io FAR_0x20 I -Io LAM_0x23 I -Io
LAK_ 02 I -1n [N[Car oo I -1n 02_0x23 I BES
= asure do O | Measure dow [6 m|
Q2R_0x03 | - [z] 02_0x21 - [24]

CAMNopen_Error_Code_0x03 |I
CAMNopen_Error_Reg_0x03 ||
CANopenState_0=03
ECKM_Avxlians_0x03
ECKM_Error_Code_0x03

- | [hex] AFR_Ox21
- | [hex] CAMopen_Error_Code_0x21
- | [hex] CAMopen_Error_Reg_0x21

[ l [
[ l [
[ l [
[ I [
= H [hesd CaAMlopenState_x21 || —H [hex]
[ l [
[ l [
[ | [
[ | [

- | [hex] EChM_Auxiliary_0=21

1P1_0x03 - [ ECM Error_Code_0x21 - [hex]
1P2_0x03 - [uA] FAR_0x21 T
MO 0x03 - [pprr] LA 0x21 -0

) |Measurement stopped Maz. buffer level: 0%

13. Start CAN monitoring. Right now there is no data displayed. That is because the
CAN monitoring is stopped. To begin CAN monitoring, click on the Start
Visualization icon (blue triangle) on the left hand tool bar. To stop CAN monitoring,
click the Stop Measuring icon (black square) on the left hand tool bar. To begin
recording the data, click on the Start Recording icon (red circle) on the left hand tool
bar.

\I;:;: I_\_PIVI_I_I 1w _\_PLJLIIE_U/
mm | FAR_Dx01

e | 02 0x02

1| AFR_0x0Z




Appendix E: Setting Up ATI Vision for ECM Modules

NOTE: While shown here for a single LambdaCAN module, the same procedure applies for any of
ECM’s CAN-based devices as well as for multiple modules simultaneously connected on the same bus.

Introduction

Connecting ECM LambdaCAN hardware to ATI VISION software is simple and does not require any
third-party software interface. Using the ECM Configuration Tool software to produce a .dbc database
file, and the ATI VISION CANMonitor interface, any available hardware CAN interface can be used to
read LambdaCAN data.

Hardware Setup

A typical hardware configuration is shown in Figure 1. In this example, a Kvaser Leaf Light CAN-USB
adapter is used. Other supported adapters have a similar procedure. Connect the DB9 CAN connector
of the LambdaCAN to the PC to CAN adapter. Supply 11-28V DC (5A min. supply) to the
LambdaCAN.

PC with PCto CAN DB9 Connector
ATI VISION Adapter

and ECM USB ( .
Configuration L Kvaser Leaf Light

Tool o
Termination
/ Resistor
—1
DC Power Supply
11-28V
]
|
Software

e ATIVISION 3.6.2
e ECM Configuration Tool v4.13

Figure 1: Equipment Schematic Layout
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Creating a .dbc File

The ECM Configuration Tool is used to create a .dbc database file for describing the CAN messages
broadcast from the LambdaCAN. All ECM products with a CAN interface use the CANopen protocol
at 500kHz by default. To generate a .dbc file using ECM Configuration Tool:

1. Connect hardware as shown in Figure 1. Ensure LambdaCAN bi-color LED indicator near
sensor connector is visible (green during normal operation, flashing red without sensor
attached).

2. Run ECM Configuration Tool software, and select the Modules tab (or the Analyzers tab if

connecting to 5200 series analyzers).

Select CAN adapter from drop down menus as shown in Figure 2, and click START.

4. After LambdaCAN module(s) have initialized, select desired parameters to transmit from the

TPDO drop down menus for each module.

Click Generate .dbc, and save this file in a location such as the VISION Projects folder.

6. Click STOP to end CAN connection.

w

o

NOTE: Whenever TPDO’s are modified, a new .dbc file must be created.

ECM Configuration Tool || ECM

Modules ]Analyzels] Firmware Upgrade] Toggle W arnings [Mow: Off] Modules 1 Analyzers } Firrnweare Upgrada]

CAN Adapler [Kvaser ~|[Cestligrt s nicrn) | [so0kepsista] =] [gETAET Staus: [l CAN Adapter: [Kvaser [CearLontHs 0ichnl < [Sookbpsista] =] STOP | Stawus: [l

Configuration Toolz Configuration Toolz
MID  Prodd Rev.t Serialtt ECM Bus Load Log Pata [0 | MID  Prod# Rev# Seralit ECI ad Log Data [0F] |

Madule: | l | | [0z fps S dhl ] Module: [0x10 0x02  0x0E  0x034D -| | [1a% a06fps T User Manual
Task: | / ~| Total Bus Load Manual[lom‘. Set CAM Baud Tesk: |Change Mode ID =] Total Bus Load Marual Comm. | Set CAN Baud

0%, Ofps Cele. %02 i#i, w [19%, 824 s Calc. %02 in A

Set

Set Module Mode Range: w01 - 0s7F Set Module Mode

EIB | Stand-Alone | ECM recommends labeling the madule with the new NID. EIE | Stand-&lone

Mote: This function can anly be The following CAM 1Ds are used for each moduls: Mate: This function can only be
uged with one module o the bus. used with one module on the bus.

Drata for Hade [D: M AA Data for Hade ID: Ox10 TPDO: Data transmitted by module
Sensor 5/M TPDOT [ TPDOZ [ TPDO3 [ TPDO4 [ Sensor 5/N TPDOT1 ¥ TPDOZ ¥ TPDO3 v TPDO4 ¥
| =] | =] \ = | = DAABHORTEE] e | loFR -] Prra -] [Revs -]

Brm &% g [0 @ [0 o U 77 [325409 [347  kPa  [685 ohms

0:00 |0x00
Eror P CO State | j ‘ j | j C0 State |02 j |FAH j |”:"I>< j |VHCM j
’7

[o [o nfa [0x05  [20.954 % |0.307305 [com1s  ma g Y

WWW.ecm-co.com = 408-734-3433 « | os Altos, CA, USA «(c) 2011 WWW.ecm-co.com = 408-734-3433 « Los Altos, CA, USA «(c) 2011

Figure 2: ECM Configuration Tool
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Setup CANMonitor using ATI VISION

ATI VISION CANMonitor provides a method of reading general purpose information from any
available CAN channel. The .dbc file generated by the ECM Configuration Tool is used to describe the
format of the information available to VVISION. To setup a CANMonitor in ATI VISION:

1. Run ATI VISION and open an existing Project File or create a new one by clicking File -
New -> Project File. In this example the Project has been named CANMonitorProject.

File View Tools Window Help - -
[ project File
= Open... Ctrl+O .EEMX configuration File
ﬁ Calibration File
[ kaM Data File

54 Import and Export... Ctrl+Q

Recent Projects [Escreen File

£ ASCIT Text File

Recent Screens
@RTF Document File

Recent Files

Exit

Description
IVV'ISION project settings and device configuration

list.

E e SR )

ile Edit View Project | Device Tools Window Help gRS—ZﬂSE"a'PNt
USE Port

T E F=| Add Device... E5 Brrop 1 Port

j Remove LF POMCIA Port
BB Pl Port

=3 Properties =3 SPvirtual CAN Channels
S2PC Based CAN Channels

Context Menu ] specifications

Description
IVPC Based CAN Channels on this computer.
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3. Add a physical hardware device by clicking Device = Add Device, and select Kvaser CAN

Channel.

H@ File Edit View Project

Device Tools Window Help

[0z e @@= o SEETENNEN

=4 Remove Device

&5 Properties F&

Context Menu

i H D
Select Device Type -

P Kvaser CAN Channel
' Vector CAN Channel
SPEtas CAN Channel

Description
(K\taser CAN Channel on this computer

4. Select a CANMonitor device by again clicking Device - Add

CANMonitor.

“@l File Edit Wiew Project

Device Tools Window Help

IEErCEEEE e

= Remove Device

Device

\3 Computer
=2 PC Based CAN

== KvaseCharre |

= Properties Fo

Context Menu

Device, and select

52 CAN Monitor

%CCP Controller Device

%XCP Controller Device

B kwP2000 CAN Device (Flash Only)
¢ CSM DAQ Network

2 IMC DAQ Network

% IPETRONIK DAQ Metwork

Description
IVCAN bus message monitor virtual device




5. Add the .dbc file generated from the ECM Configuration Tool to CANMonitor by clicking
Device - Add CAN Database and browsing to the previously created .dbc file.

Hlﬁl File Edit View Project

Device Tools Window Help

ok s

={ Remove Device

[5)|Add CAN Database... =

Computer
= WIS2 PC Based CAN
= W52 KvaserChannel

-

& Properties Fa

CANMonitor

Ltlire:

, | = BEckE-

Look in: | | VISION Projects

MName Date modified

9/28/2011 3:18 PM
9/30/2011 5:27 PM

Type
File folder
DBC File

. Samples
2 LambdaCAMTest.dbc

1

File name: ILambdaCJ\NTest.dbc

Files of type

i : |CAN Database Files (*.dbe:"uef)

6. Enable the hardware by clicking Project = Online. The status of all of the devices should
now show a Status of Online, and a value should appear in the Data Rate column of the

Project wi

ndow.

JIEI File Edit View | Project Device Tools Window Help

-
- 2 \ehicle Manager...

tus

v Computer Proposed Values » line

E‘E PC Based C/ ne

= W52 KvaserT| M Panic Apply Base F12 ne

= WIS2 CANMGHTET Thtline

o Ml | ambdaCANTest Bctive
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7. To view data, create a new Screen File and add a Control. Click File > New - Screen File

Tools Window Help

IR [[ ) = e 6 x o - - |

Open... Ctrl+O

Import and Export... Ctrl+Q

Recent Projects
Recent Screens

Recent Files

Exit

8. Select Object > Add Control - Gauge

“ File Edit View Project | Object Dataltern Tools Window

(5] Project File
®Estrateqy File

®EEMY configuration File
ﬁ Calibration File

[ kaMm Data File
Screen File

L) ASCIT Text File
gRTF Document File

Description
VISION real-time document used for interacting with data

@ Delete Ctrl+Delete

Tile controls

m Cut
Copy
Paste

B Properties F&

DEeR@ =

Ctrl+F10

Context Menu
Track Residency
5] Clear Residency

EData List
BB stripchart Recorder

E=12D Table Grid
[E 30 Table Grid
E5tate Array
(% Gauge

1 Bar Graph

:i, Thermometer
@ LD

aLED Array
5 Seroll Bar
Oypial

i Switch

% Dashboard
CAN Trace

"Descripﬁon

Gauge




9. In the Select Data Items window open the CANMonitor file tree to view all of the available
signals. Here the O2% from Node 0x10 has been selected. Click OK to add the Data Item to
the Control.

' Select " Find

I Advanced. .. | OF I

[C1 DatakemGroups Data Item £ I Type | Canicel |
=27 CANMoritor
=& Node_{x10

“er LAM 010 CAN Signal
CAN Signal Help

Mext |
Previous |

T —

Selected Data ltems I Comments

Add |
Remove |

10. Data should be visible on the gauge.

lam@aa Lty aRE W J

02_0x10 (%)

%  CANMonitorProject

“IDefaultVehicle Zlft @B m|B] =l “‘/ % | B[ o ol ik |+ -

For Help, press F1 |— Default User |Online NUM 10/3/2011 11:46:18 AM_~
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Appendix F: LOCKing and unLOCKing dashCAN*

When dashCAN* is locked, its setup cannot be modified.
¢ To LOCK dashCAN*

Press SYS until “MOd” is displayed.
Press { until “CONF” is displayed. Then press ENT.
Press 4 until “CLOCK” is displayed. Then press ENT.

“50” will be displayed. Press T until “60” is displayed. Then press ENT.
dashCAN* is now LOCKed.

b=

¢ To unLOCK dashCAN*

1. Press SYS until “LOCK” is displayed. Then press ENT.

2. “50” will be displayed. Press T until “60” is displayed. Then press ENT.
dashCAN* is now unLOCKed.

If an unauthorized person learns that 60 is the key number, contact ECM.

42



E CM ENGINE CONTROL 586 Weddell Drive, Suite 2
Sunnyvale, CA 94089-2134
AND MONITORING USA

Phone: (408) 734-3433
FAX: (408) 734-3432
Email: sales@ecm-co.com
Web: www.ecm-co.com

EC DECLARATION OF CONFORMITY

We declare under our sole responsibility that the products:

AFM1540 Lambda Module

AFM1600 Lambda and O, Analyzer

DIS1000 Display head

EGR 4830 Analyzer

NOx 5210 NOx Analyzer

Lambda 5220 Lambda Analyzer

EGR 5230 EGR Analyzer

LambdaCAN, LambdaCANc, LambdaCANd, LambdaCANp Lambda Modules
NOxXCAN, NOXCANg, NOXCANt NOx Modules
NOx1000 NOx Module

CO/CO2CAN Module

baroCAN Module

dashCAN, dashCAN+

SIM300, SIM400, SIM500, SIM600, SIM700
BTU200

To which this declaration relates are in conformity with the essential requirements of the following standards:
EN61326: 1997/A2: 2001 (Class A & Annex A)
EN61010-1: 2001 (Electrical Safety)

And therefore conform to the requirements of the following directives:

89/336/EEC Electromagnetic Compatibility (EMC)
72/23/EEC Low Voltage Directive (LVD)

Ronald S. Patrick

Vice President Sales
February 20, 2012
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